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Introduction to module 

This module defines the competence required to operate a personal computer, including 

starting the PC, logging in, using and understanding desktop icons and their links to 

underlying programs, navigating a directory structure, saving work, printing, closing down 

the PC and working with word processing.  

This module is designed to meet the industry requirement under operate personal computer 

occupational standard, particularly for the unit of competency: Operate Personal Computer 

 

This module covers the units: 

 Start and Shutdown the computer 

 Access basic system information 

 Navigate and Manipulate desktop environment 

 Organize basic directory/ folder structure and files 

 Organize files for user and/or organization requirements 

 Print information 

 Operate application software 

 

Learning Objective of the Module 

 

 Start and Shutdown the computer 

 Access basic system information 

 Navigate and Manipulate desktop environment 

 Organize basic directory/ folder structure and files 

 Organize files for user and/or organization requirements 

 Print information 

 Operate application software 

Module Instruction 

For effective use this modules trainees are expected to follow the following module 

instruction: 

1. Read the information written in each unit 

2. Accomplish the Self-checks at the end of each unit 

3. Perform Operation Sheets which were provided at the end of units  

4. Do the ―LAP test‖ giver at the end of each unit and 

5. Read the identified reference book for Examples and exercise 

Unit one: Start computer, system information and features 
This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 
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 Check connected peripheral devices 

 Check Appropriate Input Voltage 

 Switch On/Off computer power 

This guide will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this module, you will be able to: 

 Check connected peripheral devices 

 Check Appropriate Input Voltage 

 Turn On/Off computer power 
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1.1. Checking connected peripheral devices 

A computer is more than just another household appliance. The vast amount of information 

and possibilities can be overwhelming. But you can accomplish a lot with a computer, and 

using one can be a good experience. Let's walk through getting started with your first 

computer. 

Turning on a computer for the first time can be different from one computer to the next. Your 

experience could be different from this unit. It's OK to ask someone for help. 

If you're using a desktop computer, you'll need to make sure that peripheral device such as 

keyboard, mouse, and monitor etc…are plugged into the computer case before you continue. 

Or Review our module: connect hardware peripheralto learn more. 
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1.2 OHS standards are checked Input voltage 

General Safety  

Safe working conditions help prevent injury to people and damage to computer equipment. A 

safe workspace is clean, organized, and properly lighted. Everyone must understand and 

follow safety procedures. 

Follow the basic safety guidelines to prevent cuts, burns, electrical shock, and damage to 

eyesight. As a best practice, make sure that a fire extinguisher and first-aid kit are available in 

case of fire or injury. Poorly placed or unsecured cables can cause tripping hazards in a 

network installation. Cables should be installed in conduit or cable trays to prevent hazards. 

This is a partial list of basic safety precautions to use when working on a computer: 

 Remove your watch and jewellery and secure loose clothing. 

 Turn off the power and unplug equipment before performing service. 

 Cover sharp edges inside the computer case with tape. 

 Never open a power supply or a CRT monitor. 

 Do not touch areas in printers that are hot or that use high voltage. 

 Know where the fire extinguisher is located and how to use it. 

 Keep food and drinks out of your workspace. 

 Keep your workspace clean and free of clutter. 

 Bend your knees when lifting heavy objects to avoid injuring your back. 

Electrical Safety  

Follow electrical safety guidelines to prevent electrical fires, injuries, and fatalities in the 

home and the workplace. Power supplies and CRT monitors contain high voltage. 

CAUTION 

Do not wear the antistatic wrist strap when repairing power supplies or CRT monitors. Only 

experienced technicians should attempt to repair power supplies and CRT monitors. 

Some printer parts become hot during use, and other parts might contain high voltage. Check 

the printer manual for the location of high-voltage components. Some components retain a 

high voltage even after the printer is turned off. Make sure that the printer has had time to 

cool before making the repair. 

Electrical devices have certain power requirements. For example, AC adapters are 

manufactured for specific laptops. Exchanging power cords with a different type of laptop or 

device may cause damage to both the AC adapter and the laptop. 
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1.3. Switching On computer power 

Turning on a computer 

The first step is to turn on the computer. Make sure all the cables are plugged in correctly, 

and locate the power button. It's in a different place on every computer, but it will have the 

universal power button symbol (shown below). 

 

Image of a power button icon 

Once turned on, your computer takes time before it's ready to use. You may see a few 

different displays flash on the screen. This process is called booting up, and it can take 

anywhere from 15 seconds to several minutes. 

Sign in to Windows 

Once the computer has booted up, it may be ready to use, or it may require you to log in. 

This means identifying yourself by typing your user name or selecting your profile, then 

typing your password. If you've never logged in to your computer before, you may need to 

create an account. 

 

A login screen on a laptop computer 

 

The keyboard and mouse 
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You interact with a computer mainly by using the keyboard and mouse, or a trackpad on 

laptops. Learning to use these devices on connect hardware peripheral. Most people find it 

comfortable to place the keyboard on the desk directly in front of them and the mouse to one 

side of the keyboard. 

 

Hands on keyboard positioned in front of a computer 

The mouse controls the pointer on the screen. Whenever you move the mouse across the 

desk, the pointer will move in a similar manner. A mouse usually has two buttons, which are 

referred to as the left button and the right button. You will often interact with the 

computer by moving the mouse pointer over something on the computer screen, then 

clicking one of the buttons. 

Single or double clicks?  

Single clicks are used more often than double clicks. If you use a single click and nothing 

happens, then try a double click. If you find double clicking very difficult, you can use a 

single click to select the item you want to activate, followed by pressing the Enter key. 

 

Hand on mouse controlling the pointer on the screen 

The keyboard allows you to type letters, numbers, and words into the computer. 

Whenever you see a flashing vertical line—called the cursor—you can start typing. 
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A blinking cursor in a browser's address bar 

Note that the mouse pointer is also called a cursor, but it is shaped differently. The 

keyboard cursor is also called the insertion point. 

Shutting down your computer 

When you're done using your computer, it's important to shut it down properly. 

To shut down Windows,  

Click the Start button, then Select Shut down from the menu (in some versions, this may say 

Turn off Computer or look like the power symbol). 

 

 

Restarting and Sleep mode 

You can also click the power button for more options. For example, if your computer has 

become unresponsive, you can choose Restart to quickly turn it off and on again. 

You can also choose to put your computer into Sleep mode. This turns off most of your 

computer's processes, but it remembers which applications and files are open. It allows the 

computer to start up more quickly because you won't have to wait for the operating system 

and applications to load.  

Note that your computer may go into Sleep mode automatically if you haven't used it for 

more than a few minutes. 

 

If you have a laptop, you can simply close the lid to put it into Sleep mode. 

Waking your computer from Sleep mode 
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If your computer is in Sleep mode, you'll need to wake it to use it. To wake the computer 

from Sleep mode, click the mouse or press any key on the keyboard. 

Sign out VS switch users 

If you're finished using your account, you can sign out. To do this, click the Start button, 

select the current account in the top-left corner, then choose Sign out. Other users will then 

be able to sign in from the lock screen. 

Switch between users without signing out or closing your current apps. Switching users 

will lock the current user, so you won't need to worry about someone else accessing your 

account. To do this, select the current account, then choose the desired user from the drop-

down menu. You can use this same method to switch back to the other user. 

 

 

 



 

Page 14 of 116 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Personal Computer 
 

Version -1 

Aug, 2022 

 

1.4. Basic functions of an operating system 

Definition 

An operating system is a group of computer programs that coordinates all the activities 

among computer hardware devices. It is the first program loaded into the computer by a boot 

program and remains in memory at all times. 

Functions of an operating system 

The basic functions of an operating system are: 

 Handles system resources such as computer's memory and sharing of the central 

processing unit(CPU) time by various applications or peripheral devices 

 Provides file management which refers to the way that the operating system 

manipulates, stores,retrieves and saves data. 

 Booting the computer 

The process of starting or restarting the computer is known as booting. A cold boot is 

when youturn on a computer that has been turned off completely. A warm boot is the 

process of using theoperating system to restart the computer. 

 Performs basic computer tasks 

The operating system performs basic computer tasks, such as managing the various 

peripheraldevices such as the mouse, keyboard and printers. For example, most 

operating systems now are 

 Plug and play which means a device such as a printer will automatically be detected 

andconfigured without any user intervention. 

 Provides a user interface 

A user interacts with software through the user interface. The two main types of user 

interfacesare: command line and a graphical user interface (GUI). With a 

command line interface, the userinteracts with the operating system by typing 

commands to perform specific tasks. An exampleof a command line interface is DOS 

(disk operating system). With a graphical user interface, theuser interacts with the 

operating system by using a mouse to access windows, icons, andmenus.An example 

of a graphical user interface is Windows Vista or Windows 7, 8, 10, 11.The operating 

system is responsible for providing a consistent application program interface(API) 

which is important as it allows a software developer to write an application on 

onecomputer and know that it will run on another computer of the same type even if 

the amount ofmemory or amount of storage is different on the two machines. 

 Handles system resources 
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The operating system also handles system resources such as the computer's memory 

and sharingof the central processing unit (CPU) time by various applications or 

peripheral devices. Programsand input methods are constantly competing for the 

attention of the CPU and demand memory,storage and input/output bandwidth. The 

operating system ensures that each application gets thenecessary resources it needs in 

order to maximise the functionality of the overall system. 

 Provides file management 

The operating system also handles the organisation and tracking of files and 

directories (folders)saved or retrieved from a computer disk. The file management 

system allows the user to performsuch tasks as creating files and directories, renaming 

files, coping and moving files, and deletingfiles. The operating system keeps track of 

where files are located on the hard drive through thetype of file system.  

The type two main types of file system are File Allocation table (FAT) orNew 

Technology File system (NTFS). 

File Allocation table (FAT) uses the file allocation table which records, which 

clusters are usedand unused and where files are located within the clusters. 

NTFS is a file system introduced by Microsoft and it has a number of advantages 

over theprevious file system, named FAT32 (File Allocation Table). 

One major advantage of NTFS is that it includes features to improve reliability. For 

example, thenew technology file system includes fault tolerance, which automatically 

repairs hard driveerrors without displaying error messages. It also keeps detailed 

transaction logs, which trackshard drive errors. This can help prevent hard disk 

failures and makes it possible to recover files ifthe hard drive does fail. 

NTFS also allows permissions (such as read, write, and execute) to be set for 

individualdirectories and files. 

What is Windows 10? 

Windows 10 is the most recent version of the Microsoft Windows operating system. There 

have been many different versions of Windows over the years, including Windows 

8 (released in 2012), Windows 7 (2009), Windows Vista (2006), and Windows XP (2001). 

While older versions of Windows mainly ran on desktop and laptop computers, Windows 10 

is also designed to run equally well on tablets. 

How is Windows 10 different from other versions? 

Many users complained that Windows 8, the previous version of Windows, was confusing 

and difficult to use. As a result, Windows 10 looks and feels similar to older versions. Still, 

it includes a lot of new features and improvements.  
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Start menu 

Whereas Windows 8 uses the Start screen to launch applications, Windows 10 has 

reintroduced a more traditional Start menu. It's also been expanded to make it easier to find 

important apps. 

 

 

Microsoft Edge 

This new browser is designed to give Windows users a better experience on the Web. It's 

faster, more secure, and includes a lot of new features. Microsoft Edge is meant to replace 

Internet Explorer as your default web browser, but you'll still be able to use another browser 

if you prefer. 

http://www.browserfordoing.com/
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Cortana 

Similar to Siri and Google Now, you can talk to this virtual assistant with your computer's 

microphone. Cortana can answer questions like what’s the weather like today.Perform 

simple tasks like remind you to take out the trash, and much more. 
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Multiple desktops and Task view 

Instead of keeping everything open on the same desktop, you can move some of your 

windows to a virtual desktop to get them out of the way. And the new Task view feature 

makes it easy to manage all of your open windows. 

 

Action Center 

The new Action Center is pretty different from previous versions of Windows. For example, 

it's been expanded to let you access frequently used settings, such as Wi-Fi connectivity and 

tablet mode. It's also where you'll see important notifications, so if your computer receives 

an update you'll get a notification about it here. 
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Tablet mode 

Unlike Windows 8, Windows 10 makes a clear distinction between desktops and tablets. If 

you're using a keyboard and mouse with Windows 10, you'll be in desktop mode by default. 

If your computer also has a touchscreen, you can go into tablet mode at any time. Tablet 

users can also switch back to desktop mode if they prefer. 
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1.5. Using help and support functions 

Computer's built-in help 

Everyone needs to look for help sometimes. Luckily, when you want help with a computer 

program, it‘s usually easy to find. Most programs have a help feature somewhere, and 

learning how to use it can make a big difference. You may not find everything you need, but 

your computer‘s built-in help is a great place to start. 

Different programs integrate help features in different ways. Some are like interactive 

manuals included with the program that you can open with a menu, while others are just links 

to the developer‘s support website. But they‘re always designed with the same thing in mind: 

to help you learn the features of the program and to solve problems yourself. 

How to access built-in help 

Most programs have one of two ways to access built-in help. For example, Adobe Photoshop 

Elements has a Help menu with a variety of options. Many of these options open Adobe‘s 

support page in your web browser, while others access features within the program itself. 

 

Other programs have a help button. For example, Microsoft Office 2016 has the Help tab 

with a Help button to open a search. 
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Features of a help file 

Help files can be organized in a variety of ways, including as a table of contents, FAQ, or 

searchable database. 

When you open the help panel in Office 2016, you'll see a search box. Much like a search 

engine, you type keywords in the search bar, and it will display topics relevant to the 

keywords you entered. 

 

The table of contents for Mozilla‘s support page is a broad list of categories. Clicking any of 

these hyperlinks will lead to a list of narrower topics and specific help articles. There‘s also a 

search bar to help you. 

 

Although built-in help can be useful, it may not always have the information you want. If you 

can‘t find what you‘re looking for or don‘t understand what you've found, you can usually 

ask someone you know, do a Google search, or contact support staff. It can take a little extra 

time and effort, but learning how to find solutions on your own is a valuable skill—and you‘ll 

get better at it with practice. 
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Self-check-1 

Test-I Matching 

Instruction: select the correct answer for the give choice. You have given 1 Minute for each 

question. Each question carries 2 Point. 

A B 

---------1. cold boot A. A is the process of using the operating system to 

restart the computer. 

---------2. warm boot B. is when youturn on a computer that has been 

turned off completely 

---------3. Command line 

interface 

---------4.Booting 

C. is the process of starting or restarting the 

computer  

D. window vista 

 E. disk operating system 

  

  

 

Test-II Fill in the blank 

Instruction: Fill the correct answer for the give blank space. You have given 1 Minute for 

each question. Each question carries 2 Point. 

1. When the computer booting up it require ______________and ________ 

2. mouse pointer is also called a ___________ 

3. ______________is a group of computer programs that coordinates all the activities 

among computer hardware devices 

4. Keyboard cursor is also called ________ . 

5. A computer Booting up, and it can take anywhere from _______ seconds to several 

minutes. 
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 Operation Title: change power option 

 Purpose: Changing the power options of your computer 

 Instruction: Follow the instructions below to change power option 

 Tools and requirement: 

Step 1. This operation sheet 

Step 2. Learning guides, 

Step 3. Personal computer 

 Precautions: 

 Procedures in doing the task. 

Step 1. Open the Control Panel. 

Step 2. Select Power Options. 

Step 3. Have a look at the different options and plans available. Select a 

plan/options which will conserve energy. 

Step 4. Close the Power Options Window. 

 

 

 

 

 Operation Title: How toSet our computer to Hibernate or Standby 

 Purpose:Set our computer to Hibernate or Standby 

 Instruction: 

 Tools and requirement: 

1. This operation sheet 

2. Learning guides, 

3. Personal computer 

 Precautions: 

 Procedures in doing the task. 

Step 1. Click on the Start Menu. 

Step 2. Select Shut Down. 

Step 3. A Dialog box will appear with a drop down list. Select from the drop 

down list Hibernate or Standby.  

Operation sheet 1.2    Switch on computer power 

Operation sheet 1.1    Switch on computer power 
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Lap Test 1 – Instructions 

Task 1 Apply OHS  

Task 2 Check all peripheral device plug in correctly 

Task 3 Start the computer 

Task 4 Shut down computer 

Task 5 unplug an used peripheral  
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Unit Two:  Navigate and manipulate desktop environment 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 

 Create and customize desktop icons  

 Select, open, and close desktop icons 

 Manipulate application windows 

This guide will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to: 

 Create and customize desktop icons  

 Select, open, and close desktop icons 

 Manipulate application windows 
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2.1. Create and customize desktop icons 

Desktop 

Once you've signed in, the first thing you'll see is the desktop. You can think of the 

desktop as the main workspace for your computer. From here, you can view and 

manage your files, open applications, access the Internet, and much more. 

A desktop may also refer to any of the following: 

o A desktop is a term commonly used to describe a desktop 

computer or system unit. 

o When referring to an operating system or GUI (graphical user interface), 

the desktop is a system of organization of icons on a screen. The Microsoft 

Windows desktop was first introduced with Microsoft Windows 95 and 

included with every version of Windows since then. The image below is an 

example of the Microsoft Windows 10 desktop. 

 

 

https://www.computerhope.com/jargon/d/desktopc.htm
https://www.computerhope.com/jargon/d/desktopc.htm
https://www.computerhope.com/jargon/d/desktopc.htm
https://www.computerhope.com/jargon/s/system-unit.htm
https://www.computerhope.com/jargon/o/os.htm
https://www.computerhope.com/jargon/g/gui.htm
https://www.computerhope.com/comp/msoft.htm
https://www.computerhope.com/jargon/w/win95.htm
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In this example, there are no icons on the desktop, and the wallpaper is a blue screen 

with the Windows 10 logo. Also, the taskbar is at the bottom of the desktop and 

contains the Start, taskbar icons, Windows Notification Area, and the time and date. 

What icons and items are found on the Windows desktop? 

Some of the most common icons on the desktop include those for My 

Computer, Recycle Bin, your Internet browser (e.g., Internet Explorer), and My 

Documents. On the Windows desktop, you can find the Windows Start menu through 

the Start on the taskbar, and the Windows Notification Area. 

The date and time are also shown on the desktop, in the notification area on the 

taskbar. If the date and time are incorrect, you can change the date and time from the 

desktop. 

Icons are used to represent the different files, applications, and commands on your 

computer. An icon is a small image that's intended to give you an idea at a glance of 

what it represents, like a logo. Double-clicking an icon on the desktop will open that 

application or file. 

 

A button is a command that performs a specific function within an application. The 

most commonly used commands in a program will be represented by buttons. 

https://www.computerhope.com/jargon/w/wallpape.htm
https://www.computerhope.com/jargon/t/taskbar.htm
https://www.computerhope.com/jargon/s/start.htm
https://www.computerhope.com/jargon/n/notiarea.htm
https://www.computerhope.com/jargon/i/icon.htm
https://www.computerhope.com/jargon/m/mycomput.htm
https://www.computerhope.com/jargon/m/mycomput.htm
https://www.computerhope.com/jargon/m/mycomput.htm
https://www.computerhope.com/jargon/r/recycbin.htm
https://www.computerhope.com/jargon/b/browser.htm
https://www.computerhope.com/jargon/m/msie.htm
https://www.computerhope.com/jargon/m/mydocume.htm
https://www.computerhope.com/jargon/m/mydocume.htm
https://www.computerhope.com/jargon/m/mydocume.htm
https://www.computerhope.com/jargon/s/startmen.htm
https://www.computerhope.com/jargon/s/start.htm
https://www.computerhope.com/jargon/t/taskbar.htm
https://www.computerhope.com/jargon/n/notiarea.htm
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Menus are organized collections of commands and shortcuts. Click a menu to open it 

and display the commands and shortcuts within. Then click an item in the menu to 

execute it. 

 

When you open an application or folder, it is displayed in its own window. 

A window is a contained area—like a picture within a picture—with its own menus 

and buttons specific to that program. You can rearrange multiple windows on the 

desktop and switch between them. 
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Sort by desktop icons  

The icons on the desktop can be sorted so it is easy to find them. This is a good way to 

group programs together that you use a lot. The long way to do this is to drag each 

icon with the mouse to a place on the desktop. A quicker way to sort by icons is to let 

the computer do it for you. 

The icons will sort themselves neatly in alphabetical (A-Z) order. You can also sort 

them by type, size or date. 

Sort desktop icons by Name 

This sort will place all your program shortcuts together, and sorted alphabetically; 

then, display all the folders on your desktop, also displayed in alphabetical order; and, 

finally, all the files on your desktop, themselves also sorted according to their file 

name. 

Sort desktop icons by Size 

This is a useful sort to find all the large files on your desktop, especially if you are 

running out of space and are looking for the large files you can either delete, or move 

to an external drive. Since Windows 7 will show the smallest files first, do the same 

sort again to see the largest files sorted first. 

Tip: when you sort your desktop icons by size, folders will not be sorted according to 

the size of their content; rather, they will be sorted next to program shortcuts, which 

like folders take virtually no space on your desktop (or hard drive). Keep in mind that 

some folders may take huge amount of disk space, depending on their content! 

Sort desktop icons by "Item Type" (File Type) 

Sorting files on your desktop by item type is a very simple way to quickly find a file, 

whose name you forgot, but whose type you remember (it was a PDF, an Word 

document...) This is also a useful way to sort desktop icons to file them in folders 

based on their type (we find this a good organization, since we usually remember the 

types of most files). Obviously, closely related files should be stored inside a common 

folder, regardless of their type. 

Sort desktop icons by "Date Modified" (Date Last Modified) 

Sorting files on your desktop by date last modified means that you can easily find the 

latest files you worked on, or find a particular file whose name you forgot (since you 

often remember when you last worked on that file). 

Hide or show desktop icons  

Like previous versions of Windows, some of desktop icons are visible by default in 

Windows 10: this means that when you minimize all programs and see your desktop, 
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all icons are displayed. But you can also hide your desktop icons, and show them back 

again any time you want. If you accidentally hide your desktop icons, or if a prankster 

who has access to your computer has hidden them, this lesson explains how to quickly 

and easily show your desktop icons again. 

Advantage hide desktop icons 

1. Windows starts faster when desktop icons are hidden 

2. Hiding your icons gives you a bit more privacy in a public environment 

Desktop shortcuts  

Some of the icons are automatically placed on the desktop when Windows is installed. 

You can also create shortcuts. Shortcuts are icons that represent files, folders or 

programs. They are really only a link to the real file or program. In other words, they 

are like a nickname that stands for a person's real name. 

All shortcuts have a little arrow in the lower-left corner of the icon. This indicates 

that the icon is a shortcut.  

Any file, folder or program on your computer can be a shortcut. They do not use up 

much room on your hard disk.  

It is a good idea only to make useful shortcuts. They should be used for the files or 

programs that you regularly use. 
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2.2. Selecting, opening, and closing desktop icons 

Opening applications 

You'll open applications like you would from the desktop—just click or tap the 

desired app to open it. If you don't see the one you want, select all apps to see a full 

list of applications. In this example, we'll open Microsoft Edge. 

 

 

Working with multiple apps 

When you open an app in tablet mode, it will take up the entire screen. If you want to 

open another app, select the Back or Start button near the lower-left corner. 

 

This will take you back to the full-screen Start menu so you can open another 

application. If you want to see all of your open apps, press the Task view button near 

the lower-left corner, then choose the app you want. 
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If you want to use more than one app at the same time, you can use the Snap feature. 

To do this, drag the top of an app all the way to the right or left side of the screen. 

 

The app will snap into place. You can then choose another open app to fill up the 

other side of the screen. 
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Closing apps 

There are two ways to close an app in tablet mode. The first option is to use the X in 

the upper-right corner, which is the same way you'd close an app on the desktop. 

 



 

Page 35 of 116 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Personal Computer 
 

Version -1 

Aug, 2022 

 

The other method is to press and hold the top of the app, then drag it all the way to 

the bottom of the screen to close it. 

 

 

Use Keyboard Shortcuts 

Here is a selection of some of the most common: 

 Windows key + E opens File Explorer 

 Ctrl + N opens a new File Explorer window of the same folder. 

 Ctrl + W closes the window. 

 Ctrl + D selects the address bar. 

 Ctrl + F selects the search box. 

 Ctrl + Shift + N creates a folder. 

 Alt + Up goes up a folder level. 

 Alt + Right/Left goes forward or back. 

Am I required to use tablet mode? 

If you don't like tablet mode, you don't have to use it. To return to desktop mode, open 

the Action centre, then choose Tablet mode to deselect it. Keep in mind, though, that 

some things may be more difficult to select in desktop mode if you don't have a 

keyboard or mouse to use with your device. 
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2.3. Manipulating application windows 

An application—also known as a program—is a type of software that allows you 

to complete tasks on your computer. Windows comes with many built-in applications 

you can use. For example, if you want to browse the Internet, you can use Microsoft 

Edge (or Internet Explorer if you're using Windows 8 or earlier). 

Windows 10 divides applications into two different types: Windows apps and 

Desktop apps.  

Windows apps run from the Start screen and include the apps you have already 

interacted with. Desktop apps (also called programs) are run from the Desktop. 

Desktop apps include any applications which are independent of Windows 10. For 

example, if you install Microsoft Office products such as Word or Outlook, these will 

be Desktop apps.  

Desktop apps also include some of the Windows programs. For example Paint is a 

basic art program which is included with Windows 10 as a Desktop app. 

Working with windows 

Whenever you open a file, folder, or application, it will appear in a new window. You 

can have multiple items open at the same time in different windows. You'll use 

windows all the time, so it's important to know how to switch between open windows, 

how to move and resize windows, and how to close windows when you're done using 

them. 

Parts of a window 

You'll see the same three buttons in the upper-right corner of almost every window. 

These buttons allow you to perform several functions, including these below. 

 Click the Minimize button to hide the window. The window will be minimized 

to the taskbar. You can then click the icon for that window on the taskbar to make 

it reappear. 

 

 Click the Maximize button to make the window fill the entire screen. 

 

 If the screen is maximized, the Maximize button will be temporarily replaced by 



 

Page 38 of 116 
 

Ministry of Labor and 
Skills 

Author/Copyright 

Operate Personal Computer 
 

Version -1 

Aug, 2022 

 

the Restore button. Just click it to return the window to its original size. 

 

 Click the Close button to close the window. 
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Self-check-1 

Test-I Matching 

Instruction: select the correct answer for the give choice. You have given 1 Minute for each 

question. Each question carries 2 Point. 

A B 

---------1. Icon A. Is the main workspace for your computer 

---------2. Desktop B. it can be found the bottom of the desktop 

---------3. taskbar 

---------4. button  

C. is a command that performs a specific function 

within an application 

D. used to represent the different files, applications, 

and commands 

 E.  Displays general info about your PC 

  

  

 

Test II: Short Answer writing 

Instruction: write short answer for the given question. You are provided 3 minute for each 

question and each point has 5 Points. 

a. Write two advantage of hiding desktop icons? 

b. What is application? 

c. What is shortcut? 
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 Operation Title: Add Commonly Used Icons to Desktop 

 Purpose:Add Commonly Used Icons to the Desktop easy to access  

 Instruction: Follow the procedures below  

 Tools and requirement: 

1. This operation sheet 

2. Resource files 

3. Window 10 operating system install pc 

 

 Precautions: 

 Procedures in doing the task. 

Step 1. Right-click anywhere on the desktop and click “Personalize.” 

Step 2. This will open the Personalization section of the Settings app. 

Step 3. Then, click on “Themes.” 

Step 4. Now, click on “Desktop icon settings.” 

Step 5. You can check the boxes next to the icons you want on the desktop, then 

click “Apply” and “OK” to make the changes. 

Step 6. If you want to remove icons, you can go back to the Desktop Icon 

Setting and either uncheck the boxes next to the ones you want removed 

and click “Apply,” then “OK” to save the changes. 

To change desktop Icon 

Step 7. Clicking “Change Icon….”on “Desktop icon settings.” 

Step 8. Then, you can select a new icon and click “OK.” 

 

 

 

 

Operation sheet 2.1 Create and customize desktop icons 
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 Operation Title: hide and show Desktop Icons 

 Purpose:how to hide/show icons from your desktop 

 Instruction: Follow the procedures below  

 Tools and requirement: 

1. This operation sheet 

2. Resource files 

3. Window 10 operating system install pc 

 

 Precautions: 

 Procedures in doing the task. 

To hide desktop Icon 

Step 1. Right-click empty area on the desktop  

Step 2. Click on the View submenu 

Step 3. Choose "Show desktop icons" - Windows 10 now 

displays a checkmark next to this menu item, indicating 

that icons are now visible. When you click on Show 

desktop icons, two things will happen: Windows will 

hide your desktop icons, and also remove the checkmark 

to the menu item. 

To Show desktop icon 

Step 1. Right-click empty area on the desktop  

Step 2. Click on the View submenu 

Step 3. Choose "Show desktop icons" 

 

 

 

 

Operation sheet 2.2 Create and customize desktop icons 
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 Operation Title: Manually sort your desktop icons (files and folders) 

 Purpose:You can sort your desktop files and folders (icons) by Name, by Size, by 

Item type, or by Date modified. 

 Instruction: Follow the procedures below  

 Tools and requirement: 

1. This operation sheet 

2. Resource files 

3. Window 10 operating system install pc 

 Precautions: 

 Procedures in doing the task. 

Step 1. Right-click empty area on the desktop  

Step 2. The desktop context menu will open: click on the "Sort by" 

submenu 

Step 3. The submenu expands, and offers four choices: you can sort your 

desktop files and folders (icons) by Name, by Size, by Item type, 

or by Date modified. Choose your sorting order, and Windows 10 

will re-arrange your desktop icons based on the sort order you 

picked:  

Tip: when you choose to sort your desktop icons one way, it will first sort 

them in ascending order (A-Z, from smallest to largest, etc.) But if 

you then follow the same steps, and choose the same sorting order 

once more,  

 

 

 

 

 

 

Operation sheet 2.3 Create and customize desktop icons 
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 Operation Title: open, minimize, maximize,restore,move and close window 

application 

 Purpose:open and close window application 

 Instruction: Follow the procedures below  

 Tools and requirement: 

1. This operation sheet 

2. Resource files 

3. Window 10 operating system install pc 

 Precautions: 

 Procedures in doing the task. 

StartingApplications 

DesktopapplicationsareoftenstartedfromtheStartscreen. 
Ifyouhaveinstalledprograms,you may see icons for them on the Start screen.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
OtherapplicationscanbelaunchedfromtheStartscreenbyusingtheSearchfunctionand 
searching for the application to open. 
 
ImportantNote 

Even ifa Desktopapplication isopenedfromtheStartscreen, it still 
needstobelaunched fromthe 
Desktop.WhenyouopenaDesktopapplicationfromtheStartscreen,youwillnotethatth
e Desktop will open as well.  

 

 

 

Operation sheet 2.4 Manipulating application windows 
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Task 1.Open window application 

1click on theStart.  

2Type: Paint.ThePaintapplicationwillbelocated.  

 
 

3Clickon. The Paint application will open.  

Note that Paint opens in a window with the Desktop displayed behind it. 

4Leave Paint open for the next Step. 

 

Task 2. WorkingwiththeMinimizeButton 

1Using Paint, click on the Minimize button in the top right corner of the window. 

The Paint window will display as a button at the bottom of the screen on the Taskbar.  
 
 
2To restore Paint, click onon the Taskbar.The Paint window will be displayed 
as  

You left it before it was minimized.  

3Leave Paint open for the next Task. 

 

Task 3. WorkingwiththeMaximizeButton 

Forthisexerciseitisassumedthatyourwindowstartsasthedefaultsize(i.e.notmaximized).If 
yourPaintwindowismaximized(fillsthewholescreen)clickontheRestoreDownbuttonbefore 

continuing with the Task.  

 

1 .  Using Paint, click on the Maximize buttonThe Paint window will expand to 
display fully on screen. 

2. Note that the Maximize button haschanged to display the Restore Down button 

3. Click on the Restore Down buttonto change the window 
back to its former size.  

4. Leave Paint open for the next Task. 

 

Task 4. Resizing a Window Using the Mouse Pointer 

 

1. Using Paint, position the mouse pointer at the right edge of the window, as 
shown below. The Mouse pointer will change to a double-headed arrow.  
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2. Click and drag the mouse pointer to the left to decrease the width of the window. 
Then click and drag to the right to increase the width.  

Note that the same technique can be used to increase or decrease the height of the 
window.  

3. To resize the window both vertically and horizontally, position the mouse pointer 
in the lower right corner of the window. Click and drag the mouse pointer 
diagonally away from the window to increase the size.  

 

 

 

 

 

 

 

4. Resize the Paint window to its original size. 

5. Leave Paint open for the next exercise.  

 

Task 5.Moving a Window 

1. Using Paint, click on the Title bar at the top of the window.  

2. Holding down the left mouse button, move the window around the screen.  

3. When the window is in the desired location, release the mouse button.  

4. Leave Paint open for the next exercise.  

Task 6. CloseButton 

The Close buttonis used to close windows and exit programs.  

Click on the Close buttonto close the Paint program. 

 

Notepad 

NotepadisaprogramsuppliedwithWindowswhichallowsyoutocreatesimplet
ext documents.  

Task 7. Open Notepad 

1. Click on the Start buttonat the bottom left corner of the Desktop to 
display the Start . 

2. Start typingNotepad. 

 

3. Withselected, press Enter to open Notepad. 

4. Leave Notepad open for the next exercise. 
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Menus 

SomewindowscontainamenubaratthetopofthescreeninsteadofaRibbon.Clic
kingonan itemonthemenubarwilldisplayadrop-
downmenu.Thesemenusprovideaccesstofeatures found within the 
application. Notepad has five pull down menus. 

 

 

 

Task 8. To save, open and new 

1Using Notepad, click on the word File on the Menu bar.A drop-down 
menu will display different options, e.g.New, Open, Save.  

2Click on the wordFile on the Menu bar again to turn off the drop-down 
menu. 

3Leave Notepad open for the next Task. 

Task 9. Dialog Boxes  

When we refer to a menu item in this book, it will appear in brackets, e.g. [File]. The 

next word after this will be the menu option that you are to select, e.g. choose [File] 

Page Setup means to click on the File menu and select the Page Setup option.  

Task 10. Page setup 

1. Using Notepad, choose [File] Page Setup. The Page Setup dialog box will 

display. 
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Lap Test 2– Navigate and manipulate desktop environment 

Task 1 Create word file in desktop name it file01 

Task 2 Open the file 

Task 3 Practice sizing, moving, maximizing and minimizing a window. 

Task 4 Rename file01.docx to file02.docx. 

Task 5 Create a folder in and name it TestFolder on desktop. 

Task 6 Move file02.docx to TestFolder. 

Task 7 Open a window showing the contents of the testfolder 

Task 8 Open another window that shows the contents of TestFolder (You will 

have two windows open now. Make sure file extensions show.) 

Task 9 Size the windows so that you see the contents of both on the screen. 

Make sure you can see all of the folders in the full path in both open 

windows. 

Task 10 Print the entire screen utilizing Word. Type your name and Printout 2 at 

the top of the page. 
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Unit Three: Organize basic directory/ folder structure and files 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 

 Create directory 

 Identify directory attributes 

 Copy, and move subdirectories and directories 

 Rename, hide/show subdirectories and directories 

 Access subdirectories and directories 

 Create and open documents 

 Save, print and close documents 

 

This guide will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to: 

 Create directory 

 Identify directory attributes 

 Copy, and move subdirectories and directories 

 Rename, hide/show subdirectories and directories 

 Access subdirectories and directories 

 Create and open documents 

 Save, print and close documents 
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3.1. Organize basic directory/ folder structure and file 

What is folder/Attributes? 

Folders are a way of organizing your files so that it is easy to find them. This is 

similar to a paper filing system. In a paper filing system documents are organized into 

folders that describe what is in them. For instance a folder called Power Bills will 

include gas and electricity bills and payments. Afolder called Stationery would 

contain stationery orders, bills and catalogues. It is important to give files and folders 

names that you and other members of staff can easily recognize. 

 

What are File Attributes? 

File attributes are pieces of information associated with every file and directory that 

includes additional data about the file itself or its contents. They can exist in only one 

of two states – Set or Cleared; similar to an on or off state. Attributes can be in files, 

directories, volumes and certain system objects. They are used by the operating 

system and software applications to define file system behaviour. 

 

How are File Attributes Used? 

File attributes are pieces of information associated with every file and directory that 

includes additional data about the file itself or its contents. They can exist in only one 

of two states – Set or Cleared; similar to an on or off state. Attributes can be in files, 

directories, volumes and certain system objects. They are used by theoperating system 

and software applications to define file system behaviour. 

 

Commonly Used Attributes 

A byte stores the attributes of a file, with each specific attribute assigned to a bit of a 

byte. To enable a certainattribute, the system will assign a ‗one‘ to the corresponding 

bit, which represents the ‗On‘ state. (These arereferred to as flagging or setting the 

attribute).  

 

Below are the descriptions of each attribute: 

 

o Read-Only (R): Read-Only attribute will prevent software programs from 

saving changes to a file. 

This is useful if you want to write protect a file. Note that a Read-Only file 

will not prevent it from beingdeleted. 
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o Hidden (H):A file marked with the hidden attribute will be hidden from view 

under normal viewingconditions. 

o System (S):A file or directory used exclusively by the operating system which 

should not be alteredor deleted. 

o Directory (D):This attribute is tagged to folders or sub-folders to differentiate 

them from files. 

o Archive (A):This bit is used by software applications that modify files as well 

as backup software as a―communication link‖. Some backup software (for 

example SyncBackPro and SyncBackSE) allowsincremental backups by the 

user, which only backs up files that have changed since the previousbackup. 

When the backup software archives or backs up the file, it resets the archive 

bit (tagging it zeroor Off). Any software that subsequently make changes to 

the file is expected to set the archive bit. Thuswhen the backup software runs 

the next time, it will be able to identify the modified files by analysing the 

archive bits, and backs up those files with the modified bits. 

Note that certain programs may modify the files without marking the archive 

attribute. If the backup softwareuses incremental backups to backup these files, it will 

rely on the software to set the bit appropriately. It istherefore important to note that 

you should not rely solely on this setting to ensure critical files are backed up. 
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Self-check-1 

Test-I Matching 

Instruction: select the correct answer for the give choice. You have given 1 Minute for each 

question. Each question carries 2 Point. 

A B 

---------1. Read-Only (R) 
A. Used exclusively by the operating system which 

should not be altered or deleted. 

---------2. Archive (A) B. This bit is used by software applications that 

modify files 

---------3. Hidden (H) 

---------4. System (S) 

C. Prevent software programs from saving changes 

to a file. 

D.  Hidden from view under normal viewing 

conditions. 

E. Tagged to folders or sub-folders to differentiate 

them from files. 

  

  

  

 

Test II: short Answer writing 

Instruction: write short answer for the given question. You are provided 3 minute for each 

question and each point has 5 Points. 

1. What are File Attributes? 

2. What is folder? 
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 Operation Title: Crate, rename, copy, move, delete, restore file/folder 

 Purpose:crate, rename, copy, move, delete, restore file / folder 

 Instruction: Follow the procedures below  

 Tools and requirement: 

1. This operation sheet 

2. Resource files 

3. Window 10 operating system install pc 

 

 Precautions: 

Procedures in doing the task. 

Task 1. Create folder/ file 

Step 1. Open the drive or folder where you want to create a folder. 

Step 2. Right-click a blank area of the window, and then point to New 

Step 3. ClickNew folder. 

Step 4. With the New Folder name selected, type a new name. 

Step 5.   Press Enter. 

Or press Ctrl + shift + N 

Task 2.Moving a file/folder 

Step 1. Find the folder you want to move.  

Step 2.  Right click on the file/folder 

Step 3. Select Cut from the shortcut menu that appears 

Step 4. Open the folder where you want to place it (make sure this is created 

first) 

Step 5. Right click on an empty space on the screen or File/folder you want to 

past 

Operation sheet 3.1 Organize basic directory/folder structure 

 

 



  

 

Page 55 of 116 

 

Ministry of Labour and Skills 

Author/Copyright 

Operate Personal Computer 

 

Version -1 

Aug, 2022 

 

 

 

 

Step 6. Click on Paste from the menu 

Task 3.Copying a file 

If you want to keep a file in its original location and also a copy in a new location, 

follow these steps: 

Step 1. Find the file you want to copy 

Step 2. Right click on the file 

Step 3. Select Copy from the shortcut menu that appears 

Step 4. Open the folder where you want to place it (make sure this is created first) 

Step 5. Right click on an empty space on the screen 

Step 6. Click on Paste from the menu 

Task 4.Naming and renaming files 

You name a file at the same time that you create it. File names can contain up to 255 

characters (anykeystroke on a keyboard). They can have spaces, commas, and 

semicolons and can be in upper andlower case. However, files cannot contain the 

following characters:You can rename files at any time. This is useful if you decide the 

name is not easy for other peopleto identify. 

Follow these steps to rename a file/folder: 

Step 1. Go to file/folder you want to rename and right click on it 

Step 2. Click on Rename from the shortcut menu that appears 

Step 3. Type the new name on top of the old name. As you type the old name 

will disappear 

Step 4. Press Enter or click outside the file/folder 

Task 5.Deleting files file/folder 

Follow these steps to delete a file: 

Step 1. Right click on the file you want to delete 

Step 2. Click on Delete from the shortcut menu that appears 
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Step 3. If you have saved a file on to the desktop you can delete it by dragging 

it to the Recycle Binusing the mouse 

Task 6.Restoring deleting file/folder 

There might be an occasion when you send a file to the Recycle Bin by mistake, not 

realizing that youmight still need that file for some reason. Sometimes you might not 

have kept a copy on file and soneed to restore it (get it back). 

Follow these steps to restore a file/folder that is in the Recycle Bin: 

Step 1. open Recycle Bin icon on the desktop  

Step 2. Find the file/folder you want to restore 

Step 3. Right click on the file/folder you would like to restore 

Step 4. Click on Restore from the shortcut menu that appears 

Step 5. The file is restored in its original location. 
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Lap Test: 3Instructions 

Task 1: Create the following folder structure  

A. Create the following directory structure inside my documents 

 

 

B. show the location/path/ of Auto Engine folder 
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Unit Four:  Organize User files 
This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 

 Use system browsers/search 

 Access files 

 Selecting, opening and renaming files 

 Copy/ move files 

 Deleting and restoring files 

 Erasing and formatting disks 

This guide will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to: 

 Use system browsers/search 

 Access files 

 Selecting, opening and renaming files 

 Copy/ move files 

 Deleting and restoring files 

 Erasing and formatting disks 
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4.1. Organize user files 

What is a file? 

There are many different types of files you can use. For example, Microsoft Word 

documents, digital photos, digital music, and digital videos are all types of files. You 

might even think of a file as a digital version of a real-world thing you can interact 

with on your computer. When you use different applications, you'll often 

be viewing, creating, or editing files. 

Files are usually represented by an icon. In the image below, you can see a few 

different types of files below the Recycle Bin on the desktop. 

 

File Explorer 

You can view and organize files and folders using a built-in application known as File 

Explorer (called Windows Explorer in Windows 7 and earlier versions). 

To open File Explorer, click the File Explorer icon on the taskbar, or double-click 

any folder on your desktop. A new File Explorer window will appear. Now you're 

ready to start working with your files and folders. 
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Common Windows file extensions 

Windows file names have two parts; the file's name, then a period followed by the 

extension (suffix). The extension is a three- or four-letter abbreviation that signifies 

the file type. For example, in letter.docx the filename is letter and the extension is 

docx. Extensions are important because they tell your computer what icon to use for 

the file, and what application can open the file. For example, the doc extension tells 

your computer that the file is a Microsoft Word file. 

 

File Extension File Type 

.AVI Multimedia Audio/Video 

.BAT PC batch file 

.BMP Windows Bitmap 

.CSV Comma separated, variable length file (Open in Excel) 

.DOC or .DOCX Microsoft Word for Windows/Word97 

.EXE PC Application 

.GIF Graphics Interchange Format 

.HTM or .HTML Web page source text 

.JPG or JPEG JPEG graphic 
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.MDB MS Access database 

.PDF Acrobat -Portable document format 

.PNG Portable Network Graphics 

.PPT or .PPTX PowerPoint 

.PSD Adobe PhotoShop 

.RTF Rich Text Format 

.TIF TIFF graphic 

.TXT 

ASCII text (Mac text does not  

contain line feeds--use DOS Washer Utility to fix) 

.WAV Windows sound 

.XLS or .XLSX Excel spreadsheet 

.ZIP PC Zip Compressed Archive 

 

Common places to look for files 

If you're having a difficult time finding a file, there's a good chance you can find it in 

one of the following places: 

 Downloads: By default, your computer will place downloaded files in a specific 

folder, known as the Downloads folder. If you're having trouble finding a file you 

downloaded from the Internet, such as a photo attached to an email message, this is 

the first place you should look. To view the Downloads folder, open File Explorer, 

then locate and select Downloads (below Favorites on the left side of the window). A 

list of your recently downloaded files will appear. 

 

 Default folders: If you don't specify a location when saving a file, Windows will 
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place certain types of files into default folders. For example, if you're looking for a 

Microsoft Word document, you could try looking in the Documents folder. If you're 

looking for a photo, try looking in the Pictures folder. Most of these folders will be 

accessible on the left side of the File Explorer window. 

 

 Recycle Bin: If you deleted a file by mistake, it may still be in the Recycle Bin. You 

can double-click the Recycle Bin icon on the desktop to open it. If you find the file 

you need, click and drag it back to the desktop or to a different folder. 

 

 

Tips for finding files 

If you're still having trouble finding the file you need, here are some additional tips. 

 Try different search terms. If you're using the search option, try using different 

terms in your search. For example, if you're looking for a certain Microsoft Word 
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document, try searching for a few different file names you might have used when 

saving the document. 

 Open the last application used to edit the file. If you know you used a certain 

application to edit a file, open that application and select File > Open > Recent from 

the menu. The file may appear in the list of recently edited files. 

 

Searching for files 

Let's say you recently downloaded a few photos that were attached to an email 

message, but now you're not sure where these files are on your computer. If you're 

struggling to find a file, you can always search for it. Searching allows you to look 

for any file on your computer. 

To search for a file: 

In the Search Box next to the Start button, type to search for a file. The search results 

will appear above the search box. 

Bringing your files with you 

When you're working on a document or other computer file, you can always save it to 

your computer's hard drive. Sometimes, you may want to bring your file with 

you using USB drive and open it on a different computer.  

USB drive: USB or flash drives are small, removable hard drives that plug into 
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the USB ports on your computer. They are relatively inexpensive and can be 

purchased at any store with an electronics section. 

Using a USB drive 

USB or flash drives are portable, making it easy to carry your important files and 

documents with you wherever you go. USB drives have different amounts 

of memory, or storage space. Those with more memory allow you to store more (or 

larger) files. It's helpful to know that photo and video files generally take up more 

space than written documents.  

What is formatting? 

Formatting is the process of prepping a storage device, like a hard drive, solid-state 

drive, flash drive etc, to store information. It creates a filing system that organizes 

your data and allows you to maximize the space for your files. It‘s typical to format a 

drive when a new operating system is going to be used or additional space is required. 

There are two types of formatting on a USB drive: 

 Quick format: Deletes the file system table and the root folder. This option is 

frequently used for USB flash drives to efficiently free up the available space to 

transfer or store other files. It‘s not the most secure way to delete your files 

because the data may still be recoverable with data recovery tools. 

 Full format: Will scan for bad sectors and write zeros in all sectors, which 

deletes all data permanently. This action can take a long time, depending on the 

capacity of the drive. 

File system options 

When formatting your drive, it‘s important to understand the different formatting 

options available for your ideal use. The file systems most commonly used in USB 

flash drives are: 

 FAT32 is a common option you‘ll hear because it‘s recognised by both Mac 

and Windows operating systems, but it offers no security and caps files at 4GB 

in size. Most USB flash drives will have a FAT32 file system out-of-box. It is 

the most compatible file system for older/modern computers (PC and Mac) plus 

gaming consoles and other devices with a USB port. 

 exFAT is the ideal file system for USB flash drives. It doesn‘t have the 4GB 

file size limit and it‘s compatible with most Windows and Mac operating 

systems. Older operating systems might require an update to properly read and 

write to a USB drive with an exFAT file system. 
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 NTFS format is the file system Windows likes to use by default for internal 

drives running the operating system or used as a secondary storage drive. It has 

a much larger max file size but is read-only on Mac OS X (unless you install a 

third party NTFS read/write utility). 

 Mac OS Extended is the native solution for Mac users and has the max file size 

of any of them. Only use this option if the drive will only be used in Mac OS. 

Windows will not detect this file system without a third party utility. 

There are tools available to use NTFS on a Mac (Fuse) or HFS on PC (HFSExplorer). 

Another option, for those who use both Windows and Mac OS regularly, is to 

partition your hard drive and have a portion of the drive formatted for each OS. 
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Self-check-1 

Test-I Matching 

Instruction: select the correct answer for the give choice. You have given 1 Minute for each 

question. Each question carries 2 Point. 

A B 

---------1. .EXE 
A. PC application 

---------2. .PPTX B. Power point 

---------3. .WAV 

---------4. .PDF 

C. Multimedia Audio/Video  

D. Acrobat -Portable document format  

E. Windows sound 

F. Excel spreadsheet 

  

  

  

 

Test II: short Answer writing 

Instruction: write short answer for the given question. You are provided 3 minute for each 

question and each point has 5Points. 

c. What is File? 

d. What is USB drive /flash 
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 Operation Title: Formatting drives in Windows 

 Purpose:formatting USB drives 

 Instruction: Follow the procedures below  

 Tools and requirement: 

1. This operation sheet 

2. Resource files 

3. Window 10 operating system install pc 

 

 Precautions: 

Procedures in doing the task. 

Step 1. Insert a USB drive into a USB port. 

Step 2. Open File Explorer. 

Step 3. Click on This PC from the left pane. 

Step 4. Under the "Devices and drives" section, right-click the flash drive and 

select the Format option. 

Step 5. Use the "File system" drop-down menu and select the preferred option. 

Step 6. In the "Allocation unit size" drop-down menu, use the default selection. 

Step 7. In the "Volume label" field, confirm a drive name that will appear in 

File Explorer. For example, KingstonUSB. 

Step 8. Under the "Format options" section, select the Quick format option or 

don‘t depending on the use case. 

Step 9. Click the Start button. 

Step 10. Click the Yes button. 

Step 11. Once format is finished, the USB flash drive will be all set to store 

documents, pictures, videos, and other files on the removable drive. 

 

 

 

Operation sheet 4.1Organize user files 
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 Operation Title: Search files/folder 

 Purpose: search file by name and extension name  

 Instruction: Follow the procedures below  

 Tools and requirement: 

4. This operation sheet 

5. Resource files 

6. Window 10 operating system install pc 

 

 Precautions: 

Procedures in doing the task. 

Searching 

File Explorer contains a search tool which can be used to search for files/folders that contain 

certain text, were created on a certain date, are of a particular type, etc.  

Searching from File Explorer  

The Search box is located at the right of the Address bar in the File Explorer screen. 

Search box  

 

 

To perform a basic search, select the folder or drive you wish to search in the Navigation 

Pane, enter a search term into the Search box and press Enter.  

Task 1. Search files 

Step 1. 1 Open File Explorer Navigation Pane.  

Operation sheet 4.2Organize user files 
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Step 2. 2 Click in the Search box at the top right of the window. 

Step 3. 3 Type file name you want to search: e.g. Hawkesbury. 

Step 4. As you start to type, any documents that contain the text being entered will be 

listed. 

 

 

Step 5. You can get your file easily Click on the Cancel button in the Search box to 

cancel the search.  

Step 6. Leave File Explorer open for the next Task 

Task 2.Search by extension name  

Search Tools can be used to perform more complex searches. 

Step 1. Open File Explorer Navigation Pane.  

Step 2. Click in the Search box. The Search Tools Search tab will be added to the 

Ribbon. Check the Search Ribbon is displayed.  

Step 3. In the Search box type .docx. This is the file extension given to Microsoft 

Word documents.  

Step 4. All documents with this extension will display.  

Step 5. Click on the Cancel button in the Search box.  
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Lap Test: 4Instructions 

Task 1 Search all word file from my document 

Task 2 Format USB drive 
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Unit five: Operate application software 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 

 Create word document 

 Change the Basic Setting of Documents 

 Use Mail Merge 

 Insert Tables and Images 

 Select Basic Documents Print Settings 

 

This guide will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to: 

 Create word document 

 Change the Basic Setting of Documents 

 Use Mail Merge 

 Insert Tables and Images 

 Select Basic Documents Print Settings 
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5.1. Creating word document 

Open Word 2016 from the computer desktop. On the Welcome page, note the various 

popular templates available. Click “Facet design (blank)” template for a full description. 

Click “Create” to open a document in this particular style. 

 

Microsoft Word 2016 Interface  

The way the tools and menus are organized in Word 2016 is known as the user interface.  

You will learn about The Ribbon, Quick Access Toolbar, File Menu and other key parts of 

Word.  

The Ribbon  

The Ribbon runs along the top, contains all the Word tools, and is organized into three 

parts:  

 Tabs – represent a general activity area  

 Groups – show related tools (commands) together  

 Commands – a button, expandable menu, or a box for entering related information  

Click the various Tabs: observe how the Groups and Commands change based on the 

selected Tab 
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Quick Access Toolbar 

 The Quick Access Toolbar is above the Tabs and has commands used most often, 

including ―Save‖. Place the mouse arrow over each icon (do not click) to see the name 

and use for each icon. You may customize the commands in the toolbar if you click the 

black arrow at the end of the toolbar.  

The Undo command “takes back” any changes made to the document. For example, type 

―Undo‖ in the blank document you have open, then click Undo in the Quick Access Toolbar. 

Undo keeps track of actions by sequence; if you accidentally erase (change) data in your file, 

click Undo right away to get it back. On that note, it is important to ―save early and save 

often.‖ (See ―Saving Your Work‖ on page 5.) 

 

File Menu  

The File Menu contains actions at the file level. Click the blue ―File‖ tab to the far left of 

the tabs. What you‘ll see is the ―backstage‖ area. From here, you can create a New document, 

Open an existing one, Save changes to the current document, Save As a different file with a 

different name, Print the current document, and other options. Click the ―back arrow‖ at the 

top to exit the backstage area.  

Title Bar, Help Menu, Ribbon Display Options  

The Title Bar shows the name of the program and the name (title) of your document. 

(Top-most bar in program window.) A new document has a temporary title, Document1, until 

you ―Save As‖ with a different name. To the far right on the Title Bar is the Help Menu and 

Ribbon Display options.  
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The Help Menu has articles on using the software. Not sure how to perform a certain action 

or where to find a command? Click the question mark icon to browse Help articles, or search 

for specific topics.  

 

Ribbon Display Options allow you to see more or less of the Ribbon and the work area, as a 

result.  

Take a moment to locate and explore these features in the Word program window. 

 

Using Tools in Word 

Start learning about word processing by working in a Microsoft Word 2016 document. 

Save Your Work 

To make sure you don‘t lose your work on a document, you should ―save early and save 

often.‖ Let‘s start by saving the document you have open in Word 2016: 

1. Click the blue File Button near the Tabs.  

2. Click Save As. This option is for saving, or naming, a file for the first time. 

You may create different versions of a file by ―saving as‖ a new name.  

3. Click ―My Documents‖ folder. Select your folder 

4. Name file ―My Practice Document‖. Generally, choose a name that is easy to 

remember. 

5. Click Save. 
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5.2. Changing the Basic Setting of Documents 

Get Ready for Typing 

The main workspace in Word resembles a piece of paper on your screen. Note the vertical 

blinking line, the cursor, near the top left of the paper. Cursor and mouse pointer shape offer 

hints in Word. 

The Cursor 

The cursor indicates where text will appear as you type; it also indicates font size for that 

spot. Earlier, you created a document from the ―Facet design (blank)‖ template on the 

Welcome Page. Note the size of the cursor next to the word ―Title‖. What is the font size 

value for the word ―Title‖? (Look toward the Font Group in the ribbon.) 

Now move your mouse pointer in front of the word ―Heading‖ and left-click once. This 

moves the cursor. Note the cursor size and font size value in the font size box. What is the 

font size value? 

Mouse Pointer Shape 

You may have noticed the mouse pointer changes shape as 

you move to different areas in Word. The two most common 

shapes indicate different functions. The mouse pointer arrow is 

for clicking commands, or buttons in general. The mouse 

pointer text tool (I-Beam) is for selecting text or positioning 

cursor for typing. You will use the document you have open 

now to practice using various key Groups and Commands in the 

Word Ribbon. Let‘s select and change text in your document. 

Keyboard Shortcuts 

These shortcuts are a handy way to use the mouse less. Activate them by holding down one 

of the Ctrl (Control) keys on the keyboard and tapping the corresponding key. For some 

shortcuts, you have to highlight the text first. Follow your instructor‘s directions to apply 

these shortcuts to a document (if Paragraphs document is still open, use it as an example or 

write a few new sentences on a blank page). 
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Selecting Text 

Selecting text to make edits is an important word processing skill. A common way to select 

text is: 

1. Place mouse pointer text tool next to the text. In this case, place it next to next to 

―T‖ in ―Title‖. 

2. Press the left mouse button. 

3. Drag it across the text. 

4. Let go of the left mouse button. 

Notice ―Title‖ is selected (highlighted). Go ahead and type ―My Practice Document‖. 
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Selecting Lines and Paragraphs 

To select a complete line of text (use paragraph inyour 

practice document): 

1. Place mouse pointer arrow in left margin next to line of text 

(arrow will point to the right). 

2. Left-click once to select that line of text. 

To select several lines or a paragraph: 

1. Place mouse pointer arrow in left margin next to line of 

text (arrow will point to the right). 

2. Press (hold down) the left mouse button. 

3. Drag to the end of the paragraph. 

4. Let go of the left mouse button. 

Next, you will use commands from the ribbon to edit text you have selected. 

Home Tab 

The Home Tab has the groups of commands that people use most often. 

Font Group 

The Font Group contains commands that change the appearance of the font. Font is the set of 

characters (letters, numbers, punctuation, etc.) in a particular style. For example, the 

document youcreated from the ―Facet design‖ template on the Welcome page uses 

―Trebuchet MS‖ font, but you canstill use the font commands in your document. 

Here’s how to italicize text 

1. Select the word ―Practice‖ in the document title. 

2. Click italics icon in Font Group (see screenshot). 
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TIP: Italic, like Underline, is used to emphasize words or sentences in text, and book and 

movietitles. Though italics are more common, you can use either in your documents, but use 

oneconsistently throughout. 

Notice Word automatically capitalized the first word in the sentence. If you want each word 

capitalized, as a title or header normally is, you may do it word by word or simply use 

Change Case. 

To use Change Case command: 

1. Select ―How to use this template‖. 

2. Click ―Change Case‖ command. 

3. Click ―Capitalize Each Word‖ in menu. 

TIP: A general rule to make changes to text is first select the text and then click the command 

button of your choice. You may change font size or style before you start typing, too. Look in 

the Font Group to see the font and size that will appear when you begin to type. 

Take a moment to read the paragraph in your practice document under ―How To Use This 

Template‖. You will use some commands from the Styles Group and Paragraph Group under 

the Home Tab. 

Style Group 

A document created from a template, like the one you opened earlier (Facet design blank), 

has predesigned styles for different parts of the document, such as 

paragraphs and headers. 

To apply a different paragraph style: 

1. Select paragraphs under ―How To Use This Template‖. 

2. Click ―More‖ button in Styles Group. 

3. Click ―Emphasis‖ command. 

The text remains selected. You may continue modifying, including Undo, if 

you wish. To de-select, press left arrow (cursor placed at beginning of text), right arrow 

(cursor placed at end of text) or click in an area outside theselection. 

To create a new heading (section): 

1. Click ―More‖ button in Styles Group. 
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2. Click ―Heading 1‖. 

3. Type ―Learning more about the home tab‖. 

4. Press ―Enter‖ once. 

5. Type ―The Home Tab contains the following Groups:‖ 

6. Press ―Enter‖ once. 

You now have a new header and introductory sentence. You will use commands from various 

groups at various times, so don‘t be surprised that you will use a command from the 

Paragraph Group next. 

To create a bulleted list: 

1. Click ―Bullets‖ command inParagraph 

Group. 

2. Type ―Clipboard‖. 

3. Press ―Enter‖ once. 

4. Re-create list pictured to the right 

5. (Repeat step 2 & 3 for each word). 

6. After last item in your list, press ―Enter‖ twice. 

Bullets are good for general lists of items. A numbered list is good for steps in a procedure or 

order. The steps to make a numbered list are the same, except the icon for 

numbering is 

TIP: For style or space, explore decreasing indent space for lists. Bullets or numbers 

automatically indent to set lists apart from regular text. But if you like the style of left 

margin alignment, the bullets or numbers set the list apart from the text sufficiently. 

Clipboard Group 

The Clipboard Group has the commands to do ―copy and paste‖ and ―cut and paste‖. 

Before you start: 

1. Make a new sub-heading in your practice document. 

a. Use ―Heading 2‖ style from Styles Group. 



  

 

Page 84 of 116 

 

Ministry of Labour and Skills 

Author/Copyright 

Operate Personal Computer 

 

Version -1 

Aug, 2022 

 

 

 

 

b. Type ―Clipboard Group‖. 

c. Press ―Enter‖ once. 

2. Type two sentences on one line.  

a. ―I want to live in a warm place. I am moving to 

Hawaii.‖ 

To Copy and Paste text: 

1. Select the text (the line of text you just typed). 

2. Click ―Copy‖ icon in Clipboard Group. 

3. Move cursor to area where you want to paste (right 

arrow, then ―Enter‖ once). 

4. Click ―Paste‖ icon in Clipboard Group. 

To Cut and Paste text: 

1. Select the text (the sentence ―I am moving…‖).Click ―Cut‖ icon in Clipboard Group. 

2. Move cursor to area where you want to paste (at beginning of first sentence on same 

line). 

3. Click ―Paste‖ icon.Can you think of a scenario where you might choose one command 

(Copy, Cut) over the other? 

TIP: Use keyboard shortcuts to save a little time. When you place the mouse pointer arrow 

over acommand without clicking, a floating box appears with the command name, keyboard 

shortcut inparenthesis and a brief description. 
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Paragraph Group 

The Paragraph Group includes commands to adjust 

line and paragraph spacing and alignment. Line 

spacing refers to when the text you‘re typinghas 

reached the end of the line and moves down tothe next 

line automatically. Paragraph spacingrefers to any 

time you press the ―Enter‖ key to starta new 

paragraph. 
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5.3. Mail Merge 

Mail merge is a tool which allows you to create form letters, mailing labels and envelopes by 

linking a main document to a data source. It is the process of combining a list of data with a 

template. 

The mail merge process involves the following: 

 The Main Document – contains the text and graphics that are the same for each 

version of the merged document. 

 Data Source – a file that contains the information to be merged into a document. For 

example, the names and addresses of the recipients of a letter. 

Mail Merge – Form Letters 

1) Open Word and create a new blank document 

2) Type the letter with all needed text and formatting, leaving room for the data from the 

data source (example: name, address, etc.) 

3) Click the Mailings tab 

4) Click Start Mail Merge 

5) Click Step-by-Step Mail Merge Wizard 

 

The Mail Merge task pane appears on the right of your screen. Note there are 6 steps. 

Step 1.  – Select Document Type 

1) Click Letters for the document type 
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2) Click Next: Starting document 

Step 2.  – Select Starting Document 

1) Click Use the current document under Select starting document 

2) Click Next: Select recipients 

Step 3.  – Select Recipients 

The recipients can come from either an existing Excel file, an Access table or you can create 

a new list in Word. 

If Using an Existing List: 

1) Click Use an existing list under Select recipients 

2) Click Browse 

3) Select the file 

4) Click Open 

5) Select the worksheet tab name that contains the data 

6) Click OK (Mail Merge Recipients opens showing the file data) 

7) Click OK 

 

8) Click Next: Write your letter 
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If Creating a New List: 

1) Click Type a new list under Select recipients 

2) Click Create 

3) Click Customize Columns to modify the list of fields 

 

4) Delete any unnecessary field names and/or add new ones 

5) Click OK 
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6) Begin typing records, hitting TAB to advance to the next field and to continue 

adding new records 

 

7) Click OK 

8) Click Save 

The recipients list will be saved as a separate file as a Microsoft Access file type. It is saved 

in the My Data Sources folder. It is recommended to save the file in this folder. 

9) Click Next: Write your letter 
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Step 4. – Write Your Letter 

1) If including an address, click the location in your document where the address data 

will be inserted 

2) Click Address block… 

3) Select the address elements you want included 

4) Click OK 

 

The field name will look like this: <<AddressBlock>> 

The address block will insert the following fields including any necessary punctuation: First 

Name, Last Name, Company, Address 1, Address 2, City, State, Postal Code.If your fields do 

not match the ones listed above or you are not using address fields, click Moreitems… 

5) Click on the field from the list 

6) Click Insert 

7) Click Close 

The field name will look like this - «First_Name» 

8) Repeat this step until all fields have been inserted. 

Remember to put spaces and punctuation where needed. 

9) Click Next: Preview your letters 

Step 5. – Preview Your Letters 
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Here is where you can preview the first page with the fields filled in. Click Next: Complete 

the merge 

Step 6.  – Complete the Merge 

1) Click Print to send directly to the printer 

2) Click Edit individual letters to create a new file 

Remember to save your document as you go. The next time you open your document and 

click on Step-by-Step Mail Merge, the data source file will be attached. 

Mail Merge – Labels 

1) Create a new blank document 

2) Click the Mailings tab 

3) Click Start Mail Merge 

4) Click Step-by-Step Mail Merge Wizard 

Step 1.  – Select Document Type 

1) Click Labels for the document type 

2) Click Next: Starting document 

Step 2.  – Select Starting Document 

1) Click Use the current document 

2) Click Label options under Change document layout 

3) Choose the label style you are using 

4) Click OK 
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5) Click Next: Select recipients 

Step 3.  – Select Recipients 

1) Click Use an existing list under Select recipients (or you can create a new list) 

2) Click Browse 

3) Select the file 

4) Click Open 

5) Select the worksheet tab name that contains the data 

6) Click OK 

7) Click Next: Arrange your labels 

Step 4. – Arrange Your Labels 

1) Click in the first label box and click on either Address block or More items to 

insert the data fields 

2) Click Update all labels to include the fields on all labels 

3) Click Next: Preview your labels 
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Step 5. – Preview Your Labels 

Here is where you can preview the labels. 

Click Next: Complete the merge 

Step 6. – Complete the Merge 

Click Print to send directly to the printer 

OR 

Click Edit individual labels to create a new file 
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5.4. Inserting Tables and Images 

Insert Tab 

The Insert Tab commands insert different elements into your document like tables and 

illustrations. 

Tables Group 

You may choose preformatted tables or add the number of rows and columns you want. For 

this exercise, you will create a 3x5 table to track DVD‘s on loan to friends. 

To insert a table into your document: 

1. Click the Add a Table icon under the Insert Tab. 

2. Select a 3-column, 5-row area in the grid. 

3. Left-click when you are ready to insert the table. 

Apply a Table Style 

1. Click into the table to activate the Table Tools tab. 

2. Choose a new design from the Design Tab. 

Complete table as shown below: 

 

TIP: Sort the list of DVDs to locate them easier (imagine if you had a longer list). Click into 

the table to activate. Under the Layout tab, click Sort to sort by title (you could also sort by 

name if you wanted to know who had what movies). 

Illustrations 

The Illustrations Group has commands to insert pictures, shapes, charts, and more. 
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How to insert a shape 

1. Click the Shapes button in the Illustrations Group 

2. Click the first shape (Explosion 1) in Stars and Banners. 

3. Place mouse pointer (cross) in a blank area. 

4. Click and drag your mouse to ―draw‖ the shape. 

5. Let go of the mouse button when finished. 

How to add text to a shape 

1. Place mouse pointer arrow in shape area. 

2. Click right mouse button once. 

3. Click ―Add Text‖ from menu. 

4. Type ―Hello‖. 

How to move a shape 

1. Place mouse pointer over shape. 

2. Look for cross-like move arrow tool. 

3. Click and drag your shape to a new spot. 

How to re-size a shape 

1. Click into the shape. 

2. Look for squares around the frame. 

3. Click and drag a frame square. 

a. Drag a corner out to enlarge proportionally. 
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Steps for inserting other types of illustrations are similar; try inserting another illustration on 

your own. 

 

 

Word Help 

The Help Menu is an excellent resource for learning how to use software. Click the question 

mark icon near the top right corner of any Office 2016 program window to 

Access Help content. 
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5.5. Selecting Basic Documents Print Settings 

Word offers a variety of page layout and formatting options that affect how content appears 

on the page. You can customize the page orientation, paper size, and page 

margins depending on how you want your document to appear. 

Page orientation 

Word offers two page orientation options: landscape and portrait. Compare our example 

below to see how orientation can affect the appearance and spacing of text and images. 

 Landscape means the page is oriented horizontally. 

 Portrait means the page is oriented vertically. 

To change page orientation: 

Step 1. Select the Layout tab. 

Step 2. Click the Orientation command in the Page Setup group. 

 

Step 3. A drop-down menu will appear. Click either Portrait or Landscape to change 

the page orientation. 

 

Step 4. The page orientation of the document will be changed. 
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Page size 

By default, the page size of a new document is 8.5 inches by 11 inches. Depending on your 

project, you may need to adjust your document's page size. It's important to note that before 

modifying the default page size, you should check to see which page sizes your printer can 

accommodate. 

To change the page size: 

Word has a variety of predefined page sizes to choose from. 

Step 1. Select the Layout tab, then click the Size command. 

 

Step 2. A drop-down menu will appear. The current page size is highlighted. Click the 

desired predefined page size. 

 

Step 3. The page size of the document will be changed. 

To use a custom page size: 

Word also allows you to customize the page size in the Page Setup dialog box. 
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Step 1. From the Layout tab, click Size. Select More Paper Sizes from the drop-

down menu. 

 

Step 2. The Page Setup dialog box will appear. 

Step 3. Adjust the values for Width and Height, then click OK. 
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Step 4. The page size of the document will be changed. 

Page margins 

A margin is the space between the text and the edge of your document. By default, a new 

document's margins are set to Normal, which means it has a one-inch space between the text 

and each edge. Depending on your needs, Word allows you to change your document's 

margin size. 

 

To format page margins: 

Word has a variety of predefined margin sizes to choose from. 
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Step 1. Select the Layout tab, then click the Margins command. 

 

Step 2. A drop-down menu will appear. Click the predefined margin size you want. 
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Step 3. The margins of the document will be changed. 

To use custom margins: 

Word also allows you to customize the size of your margins in the Page Setup dialog box. 

Step 1. From the Layout tab, click Margins. Select Custom Margins from the drop-

down menu. 
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Step 2. The Page Setup dialog box will appear. 

Step 3. Adjust the values for each margin, then click OK. 
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Step 4. The margins of the document will be changed. 

Alternatively, you can open the Page Setup dialog box by navigating to the Layout tab and 

clicking the small arrow in the bottom-right corner of the Page Setup group. 
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Printing Documents 

To access the Print pane: 

Step 1. Select the File tab. Backstage view will appear. 

 

Step 2. Select Print. The Print pane will appear. 
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Step 3. Click the buttons in the interactive below to learn more about using the Print 

pane. 
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Preview Pane 

Here, you can see a preview of how your document will look when printed. 

You can also access the Print pane by pressing Ctrl+P on your keyboard. 

To print a document: 

1. Navigate to the Print pane, then select the desired printer. 

2. Enter the number of copies you want to print. 

3. Select any additional settings if needed. 

4. Click Print. 
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Custom printing 

Sometimes you may find it unnecessary to print your entire document, in which case custom 

printing may be more suited for your needs. Whether you're printing several individual 

pages or a range of pages, Word allows you to specify exactly which pages you'd like 

toprint. 

To custom print a document: 

If you'd like to print individual pages or page ranges, you'll need to separate each entry with 

a comma (1, 3, 5-7, or 10-14 for example). 

1. Navigate to the Print pane. 

2. In the Pages: field, enter the pages you want to print. 

 

3. Click Print. 
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Self-check-1 

Multiple Choice: - Select the best response for the following statements.  

1. The first screen you see when you open Word 2016 is called the: 

a. Word screen      c. Start screen 

b. Recent screen      d. Screen saver  

2. Which of the following contains the commands you use most often, such as Save, Undo, 

and Repeat?  

a. Quick Access Screen     c. Quick Access Toolbar  

b. Quick toolbar      d. Quick command  

3. The headings that appear on the Ribbon, such as File, Home, and Insert, are called:  

a. groups       c. shortcuts  

b. tabs        d. menus  

4. Which command would you use to save a document for the first time?  

a. Save       c. Save for the first time  

b. Save As      d. none 

5. Which of the following options would you use when saving a document with a new 

filename?  

a. Save       c. Ctrl+S 

b. Save As       d. none 

 

True/False Circle ―T ―if the statement is true or ―F―if the statement is false. 

1. The New Window command launches a new window that contains the 

current document. 

2. By selecting text, the user has the ability to cut or copy the text to the 

clipboard.  
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3. Read Mode view displays the document as it will look when printed. 
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Lap Test: 5Instructions 

Instruction  

1.  Create a Directory in Drive D:  make your name as the filename  

2.     After you finish, save your file as Final.doc then save it in your folder. 

3.      Create a mail merge: 

a. Create a table fill information at sample table by your self 

sample: 

Name  Position Address  Date 

    

    

    

    

b. Letter look like this 

 

<<Date>> 

<<Name>> 

<<Position>> 

<<Address>> 

Dear <<Name>>: 

I would like to inform you that we have a new schedule for this coming semester.  You will 

now be moving up to Level 2.  

 Our new schedules are as follows: 
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 Day    Time 

Tuesday   2:30 – 6:30 

Wednesday   2:30 – 11:30 

Thursday   2:30 – 11:30  

Friday    2:30 – 6:30 

Yours sincerely 

<<Name> 
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